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Programovacie nástroje

• Slúžia na vývoj aplikácií
• Vývojové prostredie (vytvorenie zdrojového kódu, ladenie, preklad, …)

• Programovací jazyk:
• Interpretačný – nevytvorí sa samostatná aplikácia spustiteľná bez prostredia/podpory, 

napr. Visual Basic, Matlab, Phyton, …

• Vytvorenie samostatnej aplikácie, bežiacej mimo vývojového prostredia (inštalačné 
súbory pre inštaláciu na hostiteľskom PC, .exe, … vytorenie cez preklad a “application 
builder”)

• Charakter programovacieho jazyka:
• Textovo orientovaný, napr. Rôzne verzie C

• Grafický, napr. LabVIEW



Čo je LabVIEW

• Grafické programovacie prostredie firmy NI (National Instruments) 
vytvorené pre vývojárov, ktorí:

• sú odborníkmi v oblasti merania, elektroniky, riadenia technológií, robotiky, 
komunikačných systémov atď.

• Nie sú profesionálni programátori, ale potrebujú v svojej práci vytvárať aplikácie 
najmä pre meranie a riadenie technologických procesov.

• Hlavné výhody:
• Jednoduché programovanie zostavením logických diagramov
• Dá sa rýchlo naučiť
• Široká podpora pre meracie a testovacie systémy, spracovanie signálov, komunikácie, 

riadenie technológií, spracovanie obrazov, … 
• Vývoj aplikácií pre rôzne operačné systémy nie iba (Win, Linux, Real time) a HW 

platformy (PC, real time HW, FPGA, …)



LabVIEW v predmete – ciele a využitie

• Zoznámiť sa so základmi a získať základné praktické skúsenosti

• Demoštrácia programovanie rôzneho meracieho HW

• Riešenie projektov

• Prístup k prostrediu:
• Katedrová licencia – inštalované na všetkých PC v laboratóriu
• Študentská verzia – každý student môže stiahnuť a nainštalovať s prideleným 

študentským sériovým číslom (na cvičení, aktivacia, registrácia potrebná s 
tuke mailom)

• Community edition – voľne dostupná verzia, ale nemá sa používať vo výučbe 
na univerzitách.



Praktická inštalácia

• Stiahnuť inštalačné súbory z  https://www.ni.com/labview verzie Q1 
2023 alebo Q3 2022, 32 alebo 64 bit)

• Inštalácia prebieha cez pomocnú aplikáciu Package manager, kde sa dajú zvoliť 
rôzne súčasti a doplnky (aj následne).

• Pre predmet stačí LabVIEW Professional, DAQmX a VISA

• Následne je potrebné aktivovať nainštalovanú verziu s prideleným 
študentským sériovým číslom.

• Návod na inštaláciu a základný kurz programovania je dostupný na 
Getting Started with LabVIEW (ni.com) -
https://learn.ni.com/learn/article/labview-tutorial

https://www.ni.com/labview
https://learn.ni.com/learn/article/labview-tutorial


Ako sa programuje

• Programy sú nazývané VI z slov Virtual Instrument a pri uložení na disk majú 
príponu .vi

• Viacero VI môže byť spojené v projekte (.prj) spolu s ďalšími súbormi a podporami 
ako grafika, DLL, doplnkové knižnice a toolkity, …)

• Každé VI obsahuje dve okná
• Diagram – predstavuje zdrojový kód v grafickej podobe
• Front panel – obrazovka užívateľa program s ovládacími a zobrazovacími prvkami

• Na hornej lište v každom okne je skupina tlačidiel pre ladenie a úpravy zdrojového 
kódu a grafiky

• Programovanie sa realizuje výberom grafických prvkov – ikon z palety a ich 
následným prepojením “vodičmi”, ktorý predstavujú toky (prenos) dát medzi 
ikonami.

• Obdobne výberom z palety grafických prvkov sa tvorí aj Front panel.



• Praktické predstavenie:
• Spustenie

• Okno a ovládacie prvky

• Vybrané časti palety pre Diagram – rýchly prehľad (Structure, Array, Cluster, 
Numeric, Boolean, String, …

• Vybrané časti palety pre Front panel

• Súvislosť medzi prkom na Front a Diagrame (terminal)



Spustenie

• Cez Create project je možné vytvoriť prázdne VI (Blank VI) alebo
projet. Alternatívne je možné otvoriť už existujúce súbory.

• Cez help a Find example sa je 
možné dostať k obvovskému
množtvu príkladov z rôznej oblasti



Nové prázdne VI



Front Panel
• Vytvorenie z grafických symbolov (prvkov) z knižníc alebo užívateľom vytvorených

• Prístup:
pravé tlačidlo myši (ďalej iba PTM) alebo
View»Controls Palette

• Výber a umiestnenie: ľavé tlačidlo

• Editácia umiestneného: pravé tlač.



Block diagram
• Vytvorenie VI z iných VI (SubVI) z knižníc alebo užívateľom vytvorených

• Postup výberu obdobný ako v Front Paneli
alebo View»Function Palette

• Interaktívny pomocník:
Help»Show Context Help, skrátene (Ctrl-H)



Lišta nástrojov v okne diagramu a front 
panelu

Štart        Krokovanie  Rozstupy

 Stop, pauza   Vlastnosti písma           Zoskupenie, poradie

Sledovanie behu programu (spomalene) 

Front panel

 Režim pamätania si všetkých hodnôt dát           Help

Cyklický štart    Zarovnávanie

Prekreslenie diagramu



Projekt - *.lvprj =

• Zoznam +

• Konfiguračné
informácie +

• Podmienky pre
Build +

• Podmienky pre tvorbu šírenie aplikácie (generovanie inštalačných 
súborov) +

• ...



Controls a Indicators

• Každý prvok na Paneli je buď ovládacím prvkom (Control) 
alebo indikátorom

• Vlastnosti prvku
sú nastaviteľné
cez menu pod
pravým tlačidlom
myši



Vlastnosti - Properties

• Väčšina vlastností je nastaviteľná 
cez položku Properties



Väzba panel - diagram

• Každý prvok na paneli má terminal (obraz, zakončenie, ukotvenie) v 
diagrame



Blokový diagram

• Obsahuje
• uzly:

• Terminály

• SubVI

• Funkcie

• Konštanty

• Štruktúry, napr. slučky

• Spoje (vodiče, Wires)



Funkcie myši

• Vyvolanie nastavovacieho panelu: Shift-PTM alebo VIEW»Tools 
Palette

Automatický režim =  funkcia myši sa prepína podľa umiestnenia nad objektom

Vyskúšanie ovládania prvkov  Prepnutie auto/manual funkcie myši

Vytvorenie toku dát (spoja)   Editácia textov     Otváranie nastav. 
            menu uzla

Vloženie/zrušenie breakpointu   Posúvanie v okne

Vloženie/zrušenie sondy (probe)  Kopírovanie farby

pre zobrazenie dát pri ladení

     Nastavovanie farieb



Vstupy a výstupy uzlov

• Každá funkcia – ikona má vstupy a výstupy dát

• Vysvetlenie v kontextovom pomocníkovi (Ctrl-H) a podrobne v detailnom 
pomocníkovi

• Vstupy uzlov sú zväčša polymorfné – akceptujú ľubovoľné „rozumné“ typy 
dát (číselné, textové, zoskupené – štruktúra, cluster)



Spoje (Wires)
• Určujú toky dát medzi ikonami (prenos dát medzi uzlami)

• Farba a tvar udáva typ dát

• Vytvorenie spojov:
• Myš nad vstupom/výstupom automaticky zmení funkciu na režim kreslenia spojov
• Prepne sa funkcia myši na režim spojovania z View»Tools Palette

• Mazanie: označenie a Delete alebo Ctrl-B pre všetky chybné

• Vkladanie uzlov a rôzne nastavenia cez menu pod PTM



Hierarchická štruktúra - Sub VI
• Akákoľvek časť programu (podprogram, nová funkcia) môže byť vytvorená ako SubVI a 

zastúpená vo vyššej úrovni novým symbolom (ikonou) so vstupmi a výstupmi

• Vytvorenie SubVI
• Vytvorte program, kde budúce vstupy a výstupy sú zastúpené grafickými prvkami na Front 

paneli (to isté ako pri samostatnom programe)

• V okne Front panel PTM na symbol 
a z menu vyberte:

• Edit icon – vytvoríte nový zastupujúci graf. symbol

• Show connector – zobrazí sa konektor,
počet vývodov môžete zmeniť cez menu pod PTM

• Vyberte myšou niektorý terminál a následne ťuknite na niektorý grafický prvok zastupujúci na 
paneli vstup alebo výstup – vznikne priradenie

• Po priradení všetkých grafických prvkov = vstupov a výstupov, uložte VI

• Toto Vi potom môžete vložiť do iného  VI ako SubVI cez položku Select a VI z Palety funkcií a 
napojiť ho na ostatné ikony cez vytvorené terminály na jeho ikone



Chyby v programe

• Principálne chyby – program sa nedá spustiť, ikona pre štart je 
“roztrhnutá” – v programe je chyba, ktorá bráni spusteniu, napr. Nie 
je ošetrený vstup ikony, kde je požadovaná hodnota, alebo sľučka FOR 
nemá určený počet opakovaní, nevhodné spojenie výstupu a vstupu
ikon a pod.

• Pri pokuse o spustenie objaví sa okno so zoznamom chýb. Kliknutím na chybu 
sa zobrazí miesto v diagrame, kde je daná chyba

• Chyby vznikajúce počas behu program, napr. vplyvom nevhodných 
nastavení – vzorkovacia frekvencia je nižšia ako dvojnásobok 
frekvencie signálu, pripojený merací prístroj neodpovedá a pod.

• Zobrazí sa chybové hlásenie s krátkym vysvetlením kde a prečo nastala chyba



Dátové typy

• Čísla
• Double (plávajúca desatinná čiarka)
• Integer (signed/unsigned s rôznou presnosťou = počet bitov)

• Booleovske hodnoty = True, False – nie čísla 1, 0!!!
• String – textové reťazce 
• Array – polia (všetky prvky poľa musia byť rovnakého typu)

• 1D – jednorozmerné (vektor)
• 2D – viacrozmerné (n dimensionálna matica)

• Cluster – ekvivalent record alebo struct v C = rôzne dátové typy spojené do 
jednej premennej/spoja (wire)

• Polymorfizmus – LabVIEW umožňuje mnohé operácie vykonať tou istou 
ikonou bez ohľadu na to, či ide o skalár alebo pole.



Číselné, Booleovské a textové operácie

• Číselné:
• Paleta Numeric – základné jednoduché matematické operácie
• Paleta Mathematics – veľké množstvo rôznych matematických funkcií

• Booleovské:
• Paleta Boolean – logické operácie a konvezia medzi Booleovskými a číselnými

dátami

• Texty:
• Paleta String – mnoštvo rônych operácií s textami včítane konverzie medzi

textm a číslom, vyhľadanie v texte atď.

• Polia – paleta Array

• Klastre – paleta Cluster, … ( najme nastavenie a výber zložky klastra)



Indexovanie v poliach od 0

1D array – jeden riadok s 10 orvkami (elementmi)

Polia

0     1     2     3     4     5     6     7     8     9

2D array – 5 riadkov a 7 stĺpcov, spolu 35 
prvkov

0    1    2    3   4     5    6
0 
1 
2 
3
4

Index prvého 
zobrazeného prvku
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Initialize Array

B. Common Array Functions
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Insert Into Array

B. Common Array Functions
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Delete From Array

B. Common Array Functions
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Array Max & Min

B. Common Array Functions
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Search 1D Array

B. Common Array Functions
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Arithmetic Functions Are Polymorphic
Combination Result

Polymorphism

31Ak polia majú rôzny rozmer, výsledné pole bude mať rozmer rovný rozmeru najmenšieho poľa



Vybrané operácie
• Paleta string a podpalety

• Konverzia čísla na string a vice-versa

• Spájanie čiastkových stringov do 
výsledného (Concatenate)

• Vyhľadanie/nahradenie reťazca
 v stringu

• ....

String



Konverzia čísla na string a vice-versa
• String>>Number/string conversion

• POZOR LabVIEW defaultne používa čiarku/bodku podľa nastavenia vo 
Windows (krajina). Je ale možné vo 
formáte konverzie zmeniť a 
definovať fixne čiarku alebo bodku

String

%,; Comma decimal separator.

%.; Period decimal separator.

%; System default separator. If you do not specify a separator, 
LabVIEW uses the system default separator.



Formátovaná konverzia - príklady



Klástre (clusters)
• Zoskupenie rôznych dátových typov do jednej štruktúry

• Dôvod: zníženie počtu čiar v grafe, vstup/výstupov v SubVI, zviazanie dát, 
ktorý spolu významovo súvisia, ...

• Pevná dĺžka (počet a typy zložiek)

• Cluster môže byť vo forme konštanty, indikátora alebo kontrolu

• Cluster je možné vytvoriť (definovať) umiestnením vybraných 
dátových typov do formálnej štruktúry vo forme rámčeka

• Poradie ako sa vkladajú zložky do clustra pri definícii určuje aj poradie ako sa 
z klastra vyberajú. Toto poradie je možné aj dodatočne zmeniť

• Ak majú zložky vytvárajúce klaster názvy (label), je možné ich hodnoty meniť 
alebo vyberať aj podľa mena 



Príklady
• Vytvorenie clustra (do „kontainera“ sa vložia zložky)

• Zmena poradia zložiek clustera

• Operácie s klástrami:
• Zmena hodnoty zložky clustra

• Výber hodnoty zložky clustra



Špeciálne clustre
• Error:

• Status (boolean) – nastala (True)/nenastala chyba

• Kód chyby – číslo (integer) pre identifikáciu chyby v čísleníku chýb

• Zdroj (source) – text (string) udávajú miesto vzniku chyby

• Waveform – používa sa najmä pre vzorky signálu:
• Čas vzniku signálu

• Perióda vzorkovania

• Vzorky signálu (array)

• ... Ďaľšie, napr. pre spektrum (obdoba waveform)



Grafy
• V palete Graph (Front panel):

• Chart – postupne sa dokresľujú ďalšie body (vzorky) – vhodné pre zobrazenie 
pomaly sa meniacich veličín, napr. teplota

• 3 módy – viď demonštráciu

• Graph – vykresľuje sa úsek signálu obdoba osciloskopu (vsutopm je pole 
alebo waveform)

• XY graph – závislosť dvoch veličín (vstupom je 2D pole – dvojice hodnôt XY)

• Všetky grafy majú pripravené zoomovanie, kurzory, grafiku 
vykresľovania (body, farby, spojnice bodov) a ďalšie funkcie – stači 
povoliť v nastaveniach



Funkcie Express
• “Inteligentné” funkcie – autokonfigurovateľné = pri vložení do okna diagramu 

alebo
po dvojkliku sa otvára
konfiguračné okno, v 
ktorom užívateľ nastaví
požadovanú aktivitu z 
ponúkaného sortimentu

• Nastavené aktivity je
možné upravovať cez 
vstupy ikony počas 
behu programu



Najbežnejšie štruktúry v programe

• FOR a WHILE – opakovanie určitej činnosti úseku program 
• FOR - daný počet krát

• WHILE – do splnenia určenej podmienky

• CASE – vetvenie program – vykoná sa jedna alternatíva podľa riadiacej
podmienky (obdoba SWITCH v C)

• SEQUENCE – určenie postupnosti behu program ak nie je iný spôsob 
(tok dát)



While Loops

Sľučky
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For Loops

Sľučky
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Porovnanie FOR/WHILE

Sľučky
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Tunnels – vstupy a výstupy dát pre WHILE a FOR

44

Tunels

Vstup:
- Hodnota pri štarte štruktúry
- Pre FOR môže byť indexácia = pre každý

nasledujúci obeh sa vezme nasledujúca
hodnota z poľa

Výstup:
- Posledná hodnota z výpočtu
- Všetky hodnoty (aj medzivýsledky) vo forme

poľa
Režim sa nastavuje kikpm PTM a voľbou režimu



Auto-Indexing
• Auto-Indexing Enabled • Auto-Indexing Disabled

D. Auto-Indexing

Only one value 
(last iteration) is passed 
out of the loop.0    1     2     3    4     5

Wire remains the same sizeWire becomes thicker

1D Array
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Posuvný register

Shift register

• Umožňuje preniesť výsledkov z predchádzajúceho behu slučky do nasledujúceho
• Môže aj z niekoľkých predchádzajúcich

• Môže byť:
• Inicializovaný (daná počiatočná hodnota pre prvý beh slučky)
• Neinicializovaný (POZOR počiatočná hodnota je hodnota, na ktorej slučka skončila pri predchádzajúcom 

použití = behu v programe!!! Opakované spustenie VI pod vývojovým systémom sa považuje za opakované 
spustenie sľučky. Pri prvom použití slučky register začína z implicitnej hodnoty, napr. 0, prázdny string, 
hodnota False, … podľa typu dát)



Case Structures

Case Selector Label

Selector 
Terminal



Selector Terminal Data Types

Case Structures
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Sequence – vnútenie postupnosti aktivít
• Dve formy:     Príklad

• Flat

• Stacked

• Timed



Práca so súbormi

Paleta File
• Vysokoúrovňové – jednou ikonou sa realizuje zápis alebo čítanie
• Nízkoúrovňové – samostatné čiastočné kroky pri zápise a čítaní
• Cesty k adresáru alebo súboru – dátový formát path (pozor, nie 

je to string – potrebná konverzia
• Práca so adresármi a súbory (vytvorenie, mazanie, overenie, 

premenovanie, ...)
• Špeciálne súbory (XML, ZIP, tdm, ...)

• Súbory:
• Textové – čitateľný obsah rôznymi bežnými aplikáciami
• Binárne – je potrebné poznať vnútornú štruktúru, formáty dát, 

význam jednotlivých bytov, ...)



Typická operácia so súborom

Práca so súbormi

Open/
Create/
Replace File

Read 
and/or
Write to File

Close 
File

Check for
Errors

51



Vysokoúrovňový prístup

Práca so súbormi

Open/
Create/
Replace File

Read 
and/or
Write to File

Close 
File

Check for
Errors
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V jednej ikone sú obsiahnuté všetky 
operácie
Obmedzenie: iba pre niektoré typy 
súborov



Súbor Príklad zápis čítanie



Low-Level File I/O

Práca so súbormi

Open/
Create/
Replace File

Read 
and/or
Write to File

Close 
File

Check for
Errors
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Interakcia s užívateľom

Úloha: program má vykonať aktivitu na základe podnetu od užívateľa –
tlačidlo na front paneli, zmena hodnoty na nejakom ovládacom prvku, ....

• Riešenia:
• Cyklické zisťovanie (čítanie) aktuálneho stavu ovládacích prvkov, porovnanie s 

predchádzajúcim stavom a podľa výsledku určenej vykonanie aktivity
• Nevýhodné z hľadiska využitia výkonu počítača – procesor je vyťažený neustálym čítaním front 

panelu ale vzhľadom na rýchlosť užívateľa a počítača bude „kladné“ čítanie extrémne zriedkavé

• Využitie prerušenia odvodeného od aktivity na front paneli – štruktúra event
• Procesor v počítači obslúži požiadavku len keď vznikne (event)



Príklady porovnanie

Cyklické čítanie     Prerušenie (event)

Úloha: vytvorte program, ktorý pri každej zmene hodnoty na potenciometri 
vypíše aktuálny dátum a čas.



Ďaľšie vybrané palety

• Komunikácia s prístrojmi – paleta Instrument I/O

• Komunikácia s meracími kartami - paleta Measurement I/O

• Spracovanie signálov – paleta Signal Processing aj s pomocou palety
Waveform

• Mathematics

• Connectivity

• Data communication

• …



Measurement IO

• Ikony pre prácu s meracími
multifunkčnými kartami (DAQmX) a 
prístrojmi na karte (napr. Karta s 
funkciou multimetra, osciloskopu, 
generátora, … do PC) a iné podľa
inštalácie voliteľných toolkitov do 
LabVIEW

• Podrobnejšie aj s príkladmi v priebehu
semestra



Instrument IO

• Komunikácia s meracími prístrojmi na rôznych úrovniach a po rôznych
komunikačných rozhraniach

• Podrobnejšie neskôr v priebehu semestra



Signal Processing

• Generovanie, úprava a meranie 
parametrov signálov v čase a spektre 
(transformácie, filtrovanie, výpočet 
vzoriek , …)

• Vhodné pre:
•  prípavu dát pre generovanie cez meracie 

prístroje/karty
• Predspracovanie nameraných dát, napr. 

Filtrácia nežiadúcich zložiek v spektre
• Meranie – vyhodnotenie nameraných dát, 

napr. Spektrum, parametre impulzov, 
skreslenie signálu, …



Data communication

• Komunikácia medzi:
• Rôznymi časťami program, napr. s vyrovnávacím registrom pre vyrovnanie 

rôznej rýchlosti spracovania dát, synchronizácia aktivít, …

• Komunikácia medzi samostatnými programami

• Komunikácia s prenosom dát s rôznymi protokolmi cez internet

• …



Príklad klient server TCP

• server

• klient
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